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Introduction

Introduction

Welcome to the Video Commander Scheduler program!

The Scheduler is an add-on program which works with the Video Commander system. Video Commander already
gives you the ability to perform routing and control, as well as the ability to record and edit macros to perform jobs.
The Scheduler adds to this the ability to build a schedule of future events and the times at which they begin and
end. This is more powerful and flexible than a large time macro, because you see a simple list of all the scheduled

events, and because you can make changes to the list at any time, even while an event is in progress.

This manual describes the Scheduler program in detail. This chapter provides some background information,
including installation instructions for the Site Administrator. The next chapter provides instruction in the use of the
Scheduler program, and should be sufficient to get any user well on his or her way. The third chapter describes some

of the advanced features of the Scheduler system for more experienced users.

Installing the Scheduler
If you are the Site Administrator, you will install the Scheduler program in the Video Commander system. If your
system is networked, do the installation on the main computer (where the Video Commander Server runs).

You must have already installed the Video Commander system. If the Video Commander is not installed, do so before

proceeding.

Note: The Scheduler requires version 3.03or higher of the Video Commander system. If you have an older version of Video Commander, you must update
your system before installing the Scheduler. Running the Scheduler on an old version of Video Commander will cause General Protection Fault errors.
Step 1: Start the Setup program.

This should be an option in the Video Commander section of your Windows Start Menu. Click “Video Commander

Setup”
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Double click on the Video Commander Setup icon
to start the setup program

Step 2: Click the “Add Extension” button.

The Setup program will prompt you to insert a disk containing the extensions. Insert the Scheduler disk, verify that

the correct path to your disk drive is shown, and click “OK.”

Video Commander 5etup Ed |

IRIS Yideo Commander is installed in:
D:AIRISYWEY

Select any one of the buttons below to
perform its particular setup function.

— Setup — Tools
DevicesfLinks... | pdate Sottware I
System. . |
Workstation. . | Print Report._. |

Exit Setup I Help |
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Step 3: Select the “Scheduler” extension.

Add an Extension Ed |

Extension: RIS Momtor :
VYideo Commander 5cheduler
[other Extension driver.._] Skip

Abort

Help

dddd

On the list provided, click the “Scheduler” entry and then click the “OK” button. The Setup program will install the

necessary files. You may then exit the Setup program.

Note: If you are installing the Scheduler on additional workstations in a network, do not repeat the installation. Simply add an icon in each workstation's
Program Manager which runs the program vesched.exe from the Video Commander directory.

Things You Should Know
This manual makes several assumptions about what you, the user, already know.

You should already be familiar with the concepts of the Video Commander system. In particular, you should be

familiar with routing between a source and a destination.

You should be familiar with Microsoft Windows 95 applications. The Scheduler is consistent in its look and usage
with many Windows 95 applications. The Scheduler does not use the touch-screen style of interface used by the

main Video Commander program.

You should be familiar with using the computer keyboard, and, preferably, a mouse. The Scheduler is not designed to

be controlled by a touch screen.

If you need more information about the Video Commander system and its underlying concepts, refer to the Video
Commander User's Guide. If you need more information about Microsoft Windows 95 and its applications, consult

the User's Guide accompanying your version of Windows 95.
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This chapter will introduce you to the Scheduler, and how to use the system to accomplish basic scheduling

operations.

In particular, this chapter will:
* provide a quick overview of the Scheduler program window;
* show you how to move around the schedule;
* show you how to insert a new event;
* show you how to edit, or delete, an existing event; and

* show you how to include Video Commander macros in an event.

Starting the Scheduler

Your computer should already have the Scheduler program installed. If not, contact your Site Administrator; if that's

you, refer to the previous chapter.

The Scheduler program works with the Video Commander system. The Video Commander Server program must be
started before the Scheduler is run. If the server is not already started, double-click its icon in Windows Program
Manager to start it. If you are on a network, your computer may not be the one to run the Video Commander

Server. Check with your Site Administrator if you are unsure.

To start the Scheduler, click on its icon in the Video Commander tool bar. After a moment, the Scheduler window

will appear. You may want to resize or maximize the window to provide a maximum of display space. Alternately, you
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can click on the clock in the upper right hand corner of the screen to start the Scheduler.
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Exiting the Scheduler

The Scheduler can be shut down like most Windows applications. Choose “Exit” from the “File” menu, or
double-click the control menu button at the top left corner of the Scheduler window, or click the “X” in the upper

right hand corner of the Scheduler window.
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The Scheduler Screen
When the Scheduler program is started, the screen looks like this:

¢3 Video Commander Scheduler - Events [default date range) =l E3
File Edit “iew Help

iIXJiI _Hl |i| Tioday | -}_Iil;l IS B:20:49..
ation (44 % [

Date | Stat | Stop | Length | Description | Source [44| Destin

This is the date when the eventwill start. | | |

At the top of the window are the standard Windows title bar and the menu. Below that is a line of controls for

working with the schedule, and a clock showing the current time on your system.

In the middle of the window is the list of events. Of course, the scheduled events are different on each system. If no
events are scheduled, there will be none listed. A list too big to fit in the window can be scrolled to see additional

information.
At the bottom of the screen is a status bar. This shows helpful information while you are using the Scheduler.

As in many Windows applications, on-line help is available if you have a question and this manual isn't handy.
Pressing the “F1" key at almost any time will bring up help for the current situation. Or, if you have a question about
some part of the display, press ”Shift+F1." The mouse pointer will include a question mark, to show you are in help

mode. Click on the item for which you want help, and that help will be displayed.
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Events
Date | Stat | Stop | Length | Description | Source |[44| Destination  [44] G |2
2726 12:00pm Z&00am  14:00 Sighal test Satrewrdl @1

A schedule event is made up of a number of pieces of information, displayed on a single line in the schedule. Each
event lists the date and time when it starts, when it stops, and the length of the event. The source and destination
devices for a routing job are shown, along with flags that indicate whether the system should rewind that device
when the event finishes. Additional flags indicate whether the event involves the launch of macros, and whether the

event is recurring; these topics are discussed in the next chapter.

When the current time in the Video Commander Server reaches the start time for an event, the server routes from
the source device to the destination device. The source device is commanded to “play,” and the destination device is
commanded to “record.” (If the device has no controls associated with it, or lacks those particular commands,

nothing happens.)

When the current time in the server reaches the stop time for an event, the route is broken. Both devices are
commanded to “stop.” If the appropriate flags are set, either or both devices will also be commanded to “rewind.”

Again, if the devices don't have these abilities, nothing happens. (There is no error condition.)

The schedule screen indicates any active event (it has been started, but not yet stopped) with a yellow highlight.

This color change occurs automatically as the schedule progresses.

Any routing and control performed by the server from the schedule is, of course, reflected on the Video Commander

screen just like any other network or macro operations.

Controls

N ST R EIREE

The Scheduler window provides a line of commonly used controls for manipulating the schedule, just below the

menu bar.

When editing or creating a schedule event, the Accept (checkmark) and Cancel (X) buttons are used to keep, or
discard, the changes you have entered. They are only enabled when you have made changes. These buttons

correspond exactly to the “Enter” and “Escape” keys on your keyboard.

The field tab buttons move you back or forward one field in a schedule event. These buttons correspond to the
“Shift+Tab” key combination (back a field) and “Tab” key (forward a field).
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To the right of the field tab keys is a space where you enter changes to a field. Like some spreadsheets, you do all the
text entry in this space, not directly in the schedule table. If a field is not editable, you will be unable to select any

text within this space.

To the right of that may be several buttons which relate to the specific field you are in. The description field has no

special buttons.

If you are on the date field, the buttons can select the current date, or move forward or back one day at a time. The
buttons do not move back before the current date. (There is usually no point in entering an event that has already

happened! But if you want to anyway, you can type in the date.)

If you are on a time field or the length field, you can move forward or back by fifteen-minute increments (the double

arrow buttons) or one-minute increments (the single arrow buttons).

If you are on the source field or the destination field, you have a button which opens a list of devices you can pick
from. (This list can remain on-screen even when you are on other fields.) You can also do this by double-clicking on
the field.

If you are on a rewind field, the button toggles whether rewind is selected or not. You can also do this by

double-clicking on the field.

If you are on the macro field, the button opens the dialog for selecting macros. You can also do this by

double-clicking on the field.

If you are on the recurring field, the button opens the dialog for setting the recurring options. You can also do this by

double-clicking on the field.

The last two buttons on the screen, always present, allow you to insert (“+”) and delete (“-”) schedule events. There

are equivalent commands on the “Edit” menu.

Finally, the clock simply displays the current time on your computer for your convenience. (However, on a network,
it is the time at the computer running the server, not the time on your computer, which determines when events start
and stop.) The clock is optional, and may be turned off if it is distracting or if your computer is suffering from slow

performance.

Status Bar

The bottom line of the screen is provided as a convenience. It displays helpful information about the field you are in,
a menu option you may choose, and so on. It also displays several keyboard indicators. The status bar is optional, and

may be turned off if you want an additional line of the schedule to be displayed.



Visual Scheduler

Moving Through the Schedule

There are a variety of ways that you can navigate through the schedule, which come in handy particularly if there are

a lot of events.

The current field within the current event is always highlighted with a dark blue color. This is your current position,

and the space at the top of the window for editing, and the field-specific controls next to it, reflect this position.

You can move across the fields of an event with the “Tab” key (forward) or the “Shift+Tab” key combination
(backward). (The left and right arrow keys move the cursor within the editing space.) You can move up or down by
an event with the up and down arrow keys. You can also jump by a screenfull in either direction with the “Page Up”

and “Page Down” keys.

With the mouse, you can click on any field you like and that will become the selected position. If you want to go

somewhere off the screen, use the scroll bars to get to that position, and then click on the field you want.

For a really long schedule, you have two additional options. You can jump to “now” within the schedule by pressing
“Ctrl+A.” This moves you to the first event with a starting time greater than or equal to the current time. Or, you

can specify an exact time to go to.

From the “Edit” menu, choose “Go To,” or press “Ctrl+G.” A dialog appears for specifying the target time:

Go To Date / Time |
Date: [PEaFiEH (1] 4 I

<|ngay|}|

Cancel |

Time: |E:25:14pm Help |
<<|<| How |>|>}| —

Enter the date and time, either by typing them, or by modifying the fields with the buttons underneath them. (These

buttons work the same as the field-specific buttons in the line of controls.)

Click “*OK” to jump to the time you specified. If no event starts at exactly that time, you will go to the first event
starting after that time.
Adding an Event

Adding a new event to the schedule is quite simple. Just follow these three steps.

Step 1: Insert a new event.

From the “Edit” menu, choose “New Event.” Or, click the Insert Event button at the upper right of the window. Or,
press “Ctrl+N” on the keyboard. A new, empty event appears, with a blue highlight to indicate that changes are in

progress.

10
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Step 2: Fill in the blanks.

Enter data for each field, and press the “Tab” key to move to the next field. Press the “Shift+Tab” key combination
to move back a field if you make a mistake. You can type all your information, or you can use the special field

buttons, described earlier.

Step 3: Accept the event.

Click the Accept button at the upper left of the window or, press the “Enter” key. The event should be added to the
schedule, without the blue highlight, in its appropriate location in chronological order. (If there is a conflict which
prevents your event from being added to the schedule, a message to this effect appears and you have the opportunity

to fix the problem before accepting it again.)

In some cases, you are entering a new event which is similar to an existing event. To simplify this, you can select the
event you want to copy from, and choose “Duplicate Event” from the “Edit” menu. (On the keyboard, press
“Ctrl+D.” There is no on-screen button for this operation.) A new event is inserted, but instead of being blank, it

contains the same information as the event you started with. Make the changes you want, and then accept it.

If you decide, while creating a new event, that you don't want to do this after all, click the Cancel button in the

upper left of the window, or press the “Escape” key, to discard the new event.

Fields

Each field has certain requirements for what is valid typed input.

The date field expects a month (1-12), a day (1-31), and optionally a year. Separate each number with a slash (“/”)
or adash (“-”). If you enter a year, it can be two digits (94) or four (1994); if you omit the year, the current year is
assumed. (At the end of a year, be sure to type the year for any events for the following year!) Examples: 2-1-97; or
2/1.

A time field expects a time, as hours, minutes and seconds, in either twelve-hour or twenty-four hour format. Use a
colon (*:”) to separate the numbers. You can omit the seconds, or even the minutes. The time is treated as

twenty-four hour time unless you specify “am” or “pm;” the “m” is optional. Examples: 15:00:00; 3:00 pm; 3p.

The length field expects a duration in hours, minutes and seconds, separated by colons. You can omit the seconds, or
even the minutes. For most events, you can specify lengths as long as you like (48 hours, for example), as a way of

forcing the stop time to a different date. Examples: 5:00:00; 5:00; 5.

A device field expects an existing device name. Device names are not case-sensitive, so you can enter any mix of

upper and lower case. An unrecognized name is not saved. Examples: VCRO01; Vcr01; ver01.

The rewind, macro and recurring fields do not accept typed input. They are either “on” or “off,” as indicated by the

presence or absence of the appropriate symbol. For any of those, pressing “F8" toggles the indicator.

11
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Conflicts

It is possible for you to enter a new event which conflicts with an existing event. When you try to accept such an

event, you may see a conflict error message.

If you conflicted with a single event, that event is displayed. If you conflicted with more than one event, the message

only tells you how many events raise a conflict.

If a conflict message appears, your new event is not saved; you can modify it to remove the conflict and accept it

again, or you can cancel it and do something else.

If you have the list of devices on the screen,( see below) the Scheduler gives you advance warning of what devices
are already spoken for during the time interval you are entering. Any device which has a scheduled event that could

conflict is tagged with a small picture of a clock.

[all devices) j

(93] -]
21(39)
P )]

[&&E]

[Alert]

[&kC)

America Talking

B azeball J
w1 [BET]

[Bravn)

CG.

[Cartoon)

[CBES]

CG Barker

[CE)Scroll

[Cinernax] i

You can also choose to display only certain categories of devices, using the drop list at the top of the device palette.
This can make it easier to choose devices when working with a large list. For more on working with categories, see

the help documentation with Video Commander setup.

It is always a conflict to use the same destination device in more than one event with overlapping times. It is usually
a conflict to use the same source device as well. However, if the times and length you are entering exactly match an
existing event with the same source device, this is not a conflict. This enables you to run a source to several

destinations.

In the next chapter, we will learn about open-ended and recurring events, which have their own special

considerations for conflicts.

12
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Editing an Existing Event

The procedure for editing an event already present on the screen is not much different from adding a new event.

Step 1: Move to the event to edit.

Use the keyboard keys, or click on the event you want with the mouse. (If the event you want is off the screen, use

the scroll bars to get there.)

Step 2: Modify the data.

Change those fields you wish to. At the first change, the event gets the blue highlight, indicating changes in progress.

Step 3: Accept the event.

Click the Accept button or press the “Enter” key. As before, if there is a conflict, you will be warned; otherwise, the

schedule will be redrawn with the changed event in its proper position.

If the event you modify is active (the yellow highlight is shown), be sure you don't accidentally make the stop time
earlier than the present (or the event will never stop), and don't accidentally make the start time later than the

present, or the “play” and “record” commands will be issued again.

While you are editing (either a new or an existing event), you can use the standard Windows clipboard to hold text
from a field. The copy, cut, paste and clear commands all function on selected text in the standard way. (These
options are on the “Edit” menu, or you can use the keyboard shortcuts: “Ctrl+C” for copy, “Ctrl+X” for cut,

“Ctrl+\V” for paste, or the “Delete” key to clear.) The Scheduler does not cut and paste entire events.

Deleting an Event

When you want to get rid of an event on the schedule, the process is quite simple: select any field in the event to
remove, and click the Delete button. Alternately, choose “Delete Event” from the “Edit” menu, or type “Ctrl+K.”

The Scheduler will prompt you to be sure this is what you want to do:
Simply click the “Yes” button, and the event will be deleted.

If the event you delete is active (the yellow highlight is shown), be aware that the Video Commander system will
never finish the event. This simply means that the routing job will be left intact, and the “stop” and “rewind”
commands will never be issued. (If you want to do these things, of course, you can do so through the Video

Commander screen.)

13
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Macros in an Event

As you have seen, a schedule event can route two devices together, and perform very basic controls on any device
which supports them. Additionally, you can simulate an event with multiple destinations, by making several events

which are identical except for their destinations.

Of course, these provisions, while covering a majority of scheduling needs, can't possibly cover everything. For this
reason, the Scheduler allows an event to launch an optional macro at the start time, and another optional macro at
the stop time. By making macros to do what you want, and including them in your events, you can schedule any

operations you like, no matter how complex.

Macros are created in the main Video Commander program, either by recording a series of operations (the easiest
way), or by creating a text file containing commands in the Video Commander Macro Language, and then importing
that file into Video Commander. These techniques are discussed in our online help which also provides details for

the syntax for the macro language.

A schedule event can include a source and destination to route, macros, or both. When you are creating or editing
the event, move to the macros field (indicated with a light bulb symbol in the column heading). Double-click that
field, or click the macro button appearing among the control buttons near the top of the window. The macro

selection dialog appears:

Macro Options

Starting Macro:

Eoaizeews H
Ending Macro: Cancel
| [none] j| Help

]

[ List Private Macros

For both the start time and the stop time, you can select any Video Commander macro, or “(none),” from the

drop-down lists.

This dialog has a check-box for including private macros. If this is checked, macros that were saved as “private” for
individual users are also included in the lists. (All users' macros appear; the Scheduler does not run as any particular
user, and can access any macro.) However, since different users may have different macros with the same names, this

could be a confusing list.

Click the “OK” button to keep your macro choices and close the dialog. If one or both macros were selected, your
event will show the light bulb symbol in that field. The editing space near the top of the screen shows the titles of the

macro(s) you chose.

14
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As you can see, an event can contain three types of things to do: routing (from the source device to the destination
device), control (play, record, stop and rewind at the appropriate times), and macros. These things occur in exactly
that order: routing (if devices were specified); control (if devices were specified and the devices support it); and

launching the macros.

The macros are always executed after the other event operations have occurred. Thus, if you need a macro to run
before the routing, you should either make a separate event that starts several seconds earlier to run the macro, or

you should place the routing in your macro instead of in the schedule event.

Now that you know how the Scheduler works, how to add, edit or delete events, and how to include macros in your

events, you can easily use the Scheduler to perform a variety of useful scheduling operations.

When you are comfortable with what you have learned so far, you should move on to the next chapter, where we

present some more advanced features that can make your use of the Scheduler even more powerful and useful.

15
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Advanced Features

This chapter presents more of the features of the Scheduler system.
* Your events can be open-ended, or you can have a single event repeat on a weekly basis.
* You can print a variety of useful reports from your schedule.
* You can add or remove optional elements of the Scheduler window display.

* You can set your own preferences for several Scheduler options.

These topics are all discussed in the pages which follow.

Open-Ended Events

In some cases, you want a routing to start at a particular time, but you have no known stop time. To support this, the

Scheduler allows you to enter open-ended events.

An open-ended event is easily entered: simply enter a blank stop time or a blank length. In either case, the stop time

and length will show “...” instead of a time.

At the start time, the appropriate routing, control and/or macro will be performed. The event will get the yellow

“active” highlight. And, until you do something about it, this will never go away.

When you want the event to end, you can always go back and enter a stop time. (This stop time has to be in the
future, or it will never be executed.) Alternately, you can delete the event, and deal with the routing (if necessary)

on the Video Commander screen.

Conflicts

An open-ended event poses special conflict problems for the Scheduler. If you leave an open-ended event in the
schedule after you are really done with the event, it may conflict with new events you wish to add. But, you may not

care! So the Scheduler gives you the option of using it anyway. Simply click “Yes” at the conflict warning.

Thus, you can determine whether to allow the new event to override the open-ended event.

Note: You only have the option to ignore the conflict if your new event begins after the open-ended event. If your new event begins before the open-ended
event but ends after the open-ended event starts, this is a standard conflict which you cannot ignore..

If you have the device list on-screen, devices which are used by open-ended events are indicated with a “...” symbol.

This gives you advance warning of possible conflicts.

17
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Recurring Events

If your schedule involves a certain event which happens daily, or on a certain day or days every week, it could

quickly become tedious to keep entering these. The Scheduler solves this by providing recurring events.
A recurring event is simply a standard event which happens over and over again on certain days of the week, within
a range of dates you specify. You only enter the event once, but it appears in the schedule over and over.

Note: There are a few restrictions on recurring events. A recurring event cannot be open-ended, and must have a length which is less than twenty-four
hours.

When you are entering or editing an event, move to the recurring field (indicated by the circular arrow symbol in the
column header). Either double-click on the field, or click the recurring button among the controls near the top of

the window. The recurring options dialog opens:

“Hecunming Evenls - | When R
" Mot Recurning I Gundaps :
£ feourulonke ) ™ Mondays Cancel
Fram: ™ Tuesdaps
1= Wi stasting dates ¥ Wednosday L
i~ |— [~ Thursdags
, ™ Fridaws
CUntik ———— | Saturdays
= M cemclivag it
i

If the event is not recurring, the various recurring options are disabled. If you select the weekly recurring option, the

other fields become enabled for input.

The date range specifies the first and last dates when the recurring event will appear. You can leave these fields

blank, to set no date limits. Alternately, you can choose only a start date, or only a stop date.

Check the days of the week for which the event should occur. You must pick at least one day, but can pick any

combination, including every day (which makes a daily event).

If you specify a date range, the starting and ending dates do not have to fall on one of the days you pick. The event

will simply occur on any chosen weekday that falls within that range.

When you have set up the event the way you want, click the “OK” button to close the dialog. If you have chosen a
recurring event, the field will show the circular arrow symbol, and the editing space near the top of the window will

show your chosen weekdays.

Note: Because of the number of schedule changes, adding, editing or deleting a recurring event takes much longer than changing any other type of event,
50 you will notice a pause when you accept a change.

The date on a recurring event is irrelevant. It is displayed simply to show events in order, but you cannot edit it.

18
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A recurring event with no date range would show up on a lot of dates over the century supported by the Scheduler!
So the schedule only displays those recurring events which fall between the first and last one-time events. If you
need to see a recurring event which is not displayed anywhere on the schedule, see the Printing options in the next

section.

Conflicts

Even more than open-ended events, recurring events pose special problems with event conflicts. If you enter a
conflicting event, it may be a mistake, or it may be that you want, on a particular day, to override the recurring event

with something else.

Thus, entering an event which conflicts with a recurring event generates an error which gives you a choice, you can

choose to override the recurring event with your new event, or you can fix your new event so it doesn't conflict.

Entering a new recurring event is handled differently. The only check is to see if it conflicts with another recurring

event... and if it does, you do not have the option of ignoring the problem.

If you have the device list displayed on the screen, potential recurring device conflicts are indicated with the circular

arrow symbol. This provides advance notice that a device is in use for a recurring event.

Purging Events

As the Scheduler runs, a growing number of events remain which have already happened and are now done. There is
a way you can have the system delete events when they are done, discussed in the “Preferences” section later in this
chapter, but you may choose not to do this. So you can delete the events one at a time, if you like... but there is an

easier way.

From the “Edit” menu, choose the “Purge Events” option. This lets you specify a range of dates, within which all

non-recurring events are deleted. The dialog appears:

T - |
From: I < | TDdﬂ}'l > I 1].4 I
To: IEIEEEH? < | TDdﬂ}'l > | Cancel |

[~ Purge Partially D¥erlapping Events Help |

Specify the date range you want. The buttons beside the fields let you jump back or forward a day, or specify the

current date.

Click *OK?” to purge the events. You will be prompted to make sure you want to do this; if so, the events will be

destroyed.
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View Options

The “View” menu consists of a number of options to modify the way the Scheduler window appears. Check marks

next to the menu items indicate which elements are selected.

Bestrictions. .. Ctrl+F

v Status Bar

v [Device Palette
v Clock

v Grid

* Ak PR 12 hour clock]
Military [24 howr clock]

The Scheduler provides a number of options for specifying more narrowly what is printed or viewed.

Ty

Evernilz o Dizplay

¥ Il Sousicas and Dslinations] 1+ All Events
" Specific Souce i Dne-time Events onlp Candel I
T Gpeclic Deslination i Recusieg Events wnly

Devices o Display Hedo |

| Fe

~ D'ate Rampe
0 Defouall Alange
™ Epocifio Dates: | fan

The device options let you view every event, only those events with a specified source device, or only those events
with a specified destination device. If you need a report of what one device will be doing, pick one of those options

and choose the device from the drop-down list.

The event type options let you view the full schedule, one-time events only (omit the recurring events), or recurring
events only. Choosing recurring events only is a special report: each recurring event is displayed only once, at the

first possible date where it could appear.

The date range options let you narrow the dates for which the schedule is displayed. You can specify a start date, stop

date or both. The date range is not applied to the recurring events only view.
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The Status Bar option determines whether the bottom line of the screen is reserved for status and one-line help
information. If this is off, the schedule can display one additional event. If this is on, fields and menu options provide
quick explanations, and the state of your Caps Lock, Num Lock and Scroll Lock keys are shown (for keyboards

without those indicators).

The Device Palette is the movable, sizable window containing the list of devices. If this is shown, conflict warnings
are shown as you move between events or modify start and stop times, and for the source and destination fields, you
can pick the device. This is the same list which appears when you use the device list button in a source or

destination field.

The Clock option determines whether a real-time clock is shown at the far right of the line of controls. If you have

no need for this display, turning it off can make your system slightly faster.

The Grid option determines whether grid lines are drawn between the events and fields of the schedule. This setting

also affects the grid lines when you print a report. Set this to whichever way you find easier to read.

The AM/PM and Military options determine how times are displayed in the Scheduler. This also affects the real-time
clock display, if you have it turned on. The AM/PM setting displays a twelve-hour clock with “am” or “pm” at the
end. The Military setting displays a twenty-four hour clock, with a day ranging from 00:00 (midnight) to 23:59. This

setting does not affect how you enter times; either format is accepted for input regardless of the display setting.

The clock settings are also in the Preferences dialog, discussed in the next section.

Preferences

The Scheduler provides a dialog with several options which are left up to your personal preference. Choosing

“Preferences” from the “File” menu brings up this dialog:
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Scheduler Preferences Ed |
— Time Format
1]
&+ AM/PM (12 hour)
" Military [24 hour] Cancel
—Changing the Start Time... ———————— Help

& __changes the Length
™ _..changes the Stop Time

- Schedule Execution
v Auto delete finished events

Log file: |schedule.lug

The time format determines whether the start and stop times, and the real-time clock, display in a twelve-hour or
twenty-four hour format. This is the same as the equivalent options in the “View” menu, discussed in the previous

section. This option is saved for this workstation, and does not affect any other workstation on a network.

If you change the start time for an event, either of two things can happen: the stop time can remain the same (the
length changes), or the stop time changes by the same amount (the length remains the same). You can pick which

behavior to follow. This option is saved for this workstation, and does not affect any other workstation on a network.

The Video Commander Server can be set to automatically delete finished events. Each time a non-recurring event's
stop time is processed, that event is then deleted for you. This is useful for keeping the schedule to a manageable size,
unless you want to keep a record of the schedule after the fact. This option affects all schedule processing throughout

a network.

If you want a record of what the Scheduler has done, you can specify a log file to store this information. Specify a file
name, such as “schedule.log.” If you do have a log file, be aware that it will grow every time an event starts or stops;
over time, this file can consume a lot of disk space in the Video Commander directory unless the file is deleted or
edited.

The log file format is comma-delimited text, which can be imported by a variety of spreadsheet and database
programs. Each line contains a single event, with the following pieces of information: the date (such as “2/15/94");
the time in twenty-four hour format (such as ”15:30:00"); the word “Start” or the word “Stop,” as appropriate; the
name of the event, in quotation marks; the source device (such as “VCRO01"); and the destination device (such as
"MONITORO02").
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Printing

While you can always consult the Scheduler screen for upcoming events, it is often useful to have a printout of the

schedule. You can easily print a copy, just as it appears on the screen, to any Windows printer.
Choosing the “Print” option from the “File” menu (or pressing “Ctrl+P”) brings up the Windows print dialog. Make

any changes necessary, and click “OK” to print.

Note: The printout includes the graphic symbols for rewind, macros and recurring events. If your printer has lower than 80 dpi graphic resolution, these
symbols will not appear correctly.

The heading on the report indicates what options you chose as well as the date and time when the schedule was

printed (since it is presumably subject to change).

This concludes the Scheduler User's Guide. You should now be able to set up and manage very powerful and flexible

event schedules in your Video Commander system.

We at IRIS Technologies hope this and all of our products meet, and exceed, your expectations.
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